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GIF Slideshow User Manual

Introduction
Nowadays more and more GIF pictures are being released on CDROM, both as parts of collections 

of Public Domain software, and as complete collections of images in their own right.
Typically a CDROM can have between 3,000 and 6,500 images on a single disk. Attempting to view

each image in such a large collection can be very tedious if you have to “open” each one 
individually.

To address this problem, the application “GIF Slideshow” has been developed, and is offered as 
ShareWare. (ShareWare fee $20, see the end of this document for details).

Version 1.1
This documentation pertains to Version 1.1 of GIF Slideshow. It was produced on 21st November 

1993.

GIF Slideshow has the following features:
• Very fast decoding of images (on average, 20 images per minute on a Mac IIci)
• Automatic processing of entire folders, or entire volumes (disks)
• Pictures are automatically scaled (shrunk or expanded) so that they fit exactly onto the 

screen currently in use. They are then centred.
• Favourite pictures can be written to another location for later viewing (in effect, copying them 

from a CDROM to your hard disk)
• Pictures can be saved in TIFF format for loading into word processors or desktop publishing 

programs
• ISO 9660 CDROMs are supported (this is the format typically used for GIF pictures). GIF 

pictures are recognised by file name (i.e. ending in “.GIF”) on such disks.
• The menu bar and mouse are hidden during picture display, so that the picture is shown to its 

best advantage
• Supports all colour modes from monochrome to millions of colours (best performance and 

display is obtained if monitor is set to 256 colours)
• Simple to use: “drag and drop” interface under System 7 (just drop the icons for disks, 

CDROMs, folders and files onto the “GIF Slideshow” icon, and all GIF pictures inside them will 
be located and displayed)

• Pictures can be displayed randomly, or in sequence
• Advancing to the next picture can be manual (click the mouse, or press “space”, “return” or 

“enter”); or automatic (time delay between pictures adjustable)
• You can jump to the middle of a sequence of pictures to resume viewing a session commenced 

earlier
• A given sequences of pictures can loop indefinitely, or stop once all pictures have been displayed
• “Tag files” can be created listing files chosen by the user, so that, for example, all pictures of 

trains in a particular CDROM can be easily selected and displayed
• Information about the current picture can be optionally displayed, including its name, size, 

scaling factor (e.g. 80%), sequence (e.g. picture 56 out of 800 pictures), and amount of memory 
free

• The slide show can be temporarily paused, and the screen cleared, if necessary (this feature is 
also known as the “Boss” key)

• Coloured borders can optionally be drawn around pictures which do not fill the screen
• Works under both System 6 and System 7, supporting Apple Events under System 7
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Installing GIF slideshow
Create a folder, copy application

Create a folder on your hard disk called, for example, “GIF Slideshow folder” and then copy the 
GIF Slideshow icon into that folder. You may wish to use that folder to hold any “tag files” 
created by the program. Tag files are explained in more detail later on. GIF Slideshow creates a 
“preferences” file called “GIF Slideshow prefs” when it is run, so that it remembers settings 
such as “automatic advance” and “time between frames”. This “preferences” file is placed in the
same folder as the GIF Slideshow application. The “preferences” file may be safely deleted if 
you wish to return to default operation the next time you invoke GIF Slideshow.

Make an alias if desired
Under System 7, you may also wish to create an alias for the GIF Slideshow application, and place 

the alias on your desktop. You can then display GIF pictures by simply dropping their icons onto 
this alias.

Memory usage
GIF Slideshow partly achieves its high speed of displaying pictures by reading the next picture 

into memory and decoding it while you are viewing the current one. Consequently it needs 
enough memory to hold two pictures in memory, in both compressed and decompressed form, 
plus memory for the program code and the internal list of the names of the pictures currently 
selected (so that they can be chosen at random if desired).

You are recommended to allocate 5 Mb or more to the application if possible. To do this, select the 
GIF Slideshow icon in the Finder, and then select “Get Info” from the “File” menu (or press 
Command-I). Then type the number “5000” into the “preferred size” box (5000K is 5 Mb).

If you cannot allocate that much memory to the application you will probably be able to view most 
pictures, however if you view two large pictures consecutively you may get a message indicating
that there is not enough memory to decode one of them. You will be able to click “continue” and 
attempt to process the next one.
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Using GIF Slideshow

Selecting pictures to be displayed
Under System 7
Because of System 7’s “drag and drop” capabilities, GIF Slideshow is particularly easy to use. 

Simply drag the icons for one or more:

• GIF picture files
• Folders containing GIF pictures
• Volumes (i.e. disks, CDROMs)
• Tag files created by GIF Slideshow

onto the GIF Slideshow icon (or its alias).

If the GIF Slideshow application is not yet executing it will start running. Then you will see a 
progress window indicating the name of the current GIF picture that it has found, plus a count 
of the total number of GIF pictures located so far. When all files/folders/volumes/tag files have 
been processed the first picture will be automatically displayed.

Once you have finished viewing a sequence of pictures you can view more by simply dragging and 
dropping more icons onto the GIF Slideshow application icon. You do not need to “quit” from 
GIF Slideshow to do this. Alternatively, you can open tag files or scan folders from within the 
application as described below under “System 6”.

If “dragging and dropping” doesn’t work …
If you cannot “drag and drop” files onto the GIF Slideshow icon, or if the GIF Slideshow 

application does not have a distinctive coloured icon, then you may need to rebuild your desktop
so that the Mac recognises the new icon.

To do this, restart your Mac, holding down the Command and Option keys. When asked whether 
you want to rebuild your desktop, click OK.

Under System 6

• If you have previously created a “tag file” from within GIF Slideshow you can just double-click 
(open) this file and the GIF Slideshow will commence running, and then display all the files 
listed in that tag file.

• Otherwise, double-click on the GIF Slideshow to open the application, and then use the “File” 
menu to either read a tag file (Command-T) or scan a folder (Command-S).

To scan a folder, type Command-S (or select “Scan folder” from the File menu), and then use the 
dialogue box to open any file in the desired folder. GIF Slideshow will then read into memory the
names of all GIF pictures found in that folder, and all sub-folders below that folder, and then 
commence showing the first picture. As the entire folder is scanned it does not matter which file
you select to start with—it is merely a starting point for the scan.
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Scanning time
Time taken to scan folders
Scanning a folder on a hard disk is very fast. You can expect to take about 2 seconds to scan a 

folder with over 100 files in it. However scanning an entire volume can be somewhat slower, as 
the application has to examine every file to see if it might be a GIF picture. As a guide, the 
author’s 100 Mb hard disk took 55 seconds to scan. Scanning an entire CDROM can take 
correspondingly longer (CDROMs usually contain 600 Mb), particularly if it is a Mac CDROM 
with many sub-folders in it. Users are strongly advised to create “Tag files” of their CDROMs 
which, once initially created, are much faster to process.

Time taken to scan CDROMs
As an example, the author extracted the following times using a Mac IIci processing the “GIFs 

Galore” CDROM from Walnut Creek, 1st edition. This CDROM has 6,483 GIF pictures on it.

Initial scan of CDROM:.........10 minutes 30 seconds (do this once only)
Writing tag file:.....................1 minute 30 seconds (do this once only)
Reading tag file:....................1 minute 40 seconds (do this in the future)

As you can see, it is over 6 times as fast to read the tag file (which already has all the GIF picture 
names and folder codes in it), than to scan the CDROM directly.

Accessing the menu bar
When pictures are being displayed both the mouse and the menu bar are hidden, so that the 

picture can occupy the entire screen. You can control the application’s operation by one of the 
following methods:

• Entering the keyboard equivalents for various commands (e.g. Command-period to stop the 
display, Command-A for automatic advance and so on); or 

• Clicking the mouse in the menu bar area. While the mouse is held down the menu bar will 
temporarily reappear, so that you can see the various menus and select items from them; or

• Hiding the picture temporarily (Command-H). The menu bar will reappear and can be used at 
your leisure. Then use Command-H a second time to resume the slide show.

There is a summary of the various keyboard equivalents for each of the application’s menu items 
towards the end of this document.
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Slideshow control options
The features described below appear under the “Slideshow” menu.

Note that if you are using “manual advance” of frames, then keystrokes and mouse clicks are 
ignored until the current picture has been fully drawn on the screen.

Stopping the show
Press Command-period, or the “Esc” key and the current slide show will stop. You will then have to

re-scan or re-process a tag file in order to view further pictures. If you wish to temporarily 
pause the display, use the “Hide” feature described below instead of stopping the show.

If you wish to stop the slide show and return to the Finder, just press Command-Q (Quit) in the 
usual way.

Automatic advance
Press Command-A to toggle automatic advancing of pictures on and off. A message will briefly 

appear in the bottom right-hand corner of the screen to show what the new status is (Automatic 
or Manual advancing).

The advancing method (automatic or manual), and the delay between frames are remembered by 
GIF Slideshow for the next time you use the program.

Delay between pictures
To control the amount of time between pictures, use Command-D to set the “Delay” time in 

seconds. You are allowed to set a delay period in the range 0 to 600 seconds (i.e. zero to 10 
minutes).

Note that setting the delay period very low (e.g. 0 seconds) will mean that the amount of time 
between frames is actually the time taken to decode the next picture (which can range from 1 
second to about 5 seconds). Effectively then, a delay of “0” means “show the pictures as fast as 
possible”. A reasonable setting for the delay amount is 5 seconds which is usually enough time 
to enjoy each picture.

Manual advance when in automatic mode
Note that when “automatic advance” is activated you can still manually advance to the next 

picture by pressing “space”, “return” or “enter”, or clicking the mouse. You might use this 
technique in conjunction with a longer delay period (say, 30 seconds) to advance past boring 
pictures.

Delaying the automatic advance
Alternatively, if you have the automatic advance set to a short period, say 3 seconds, and see a 

picture you want to admire, just hold down one (or more) of the following keys: Command, 
Option, Control or Shift.

While one of the above keys is depressed, the automatic advance is temporarily disabled. When 
you let go of the key, the program then waits for the delay period to elapse before advancing to 
the next frame (e.g. if the delay period is 3 seconds, there will be a further 3 second delay from 
the time you let go of the key).

Stopping automatic advance
To disable automatic advance, just press Command-A again.
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Manual advance
To manually advance to the next picture, press any of the following keys: “space”, “return”, 

“enter”, or any letter key in the range “A” to “Z”.
Alternatively, click the mouse to advance.
When using manual advance, if you click or press a key before the picture has been fully drawn, 

the click or key-press is discarded. This is so that you do not accidentally advance too quickly by
pressing two keys in a row, or clicking twice by mistake. You must wait for the picture to 
complete drawing (and any information such as the file name to appear) before attempting to 
advance to the next picture.

If you press a “letter” key (i.e. “A” to “Z”) this key is noted in memory, and remembered when (and 
if) you create a “tag” file. You can thus use the alphabetic letters to “tag” various pictures (e.g. 
“F” for Fish, “L” for Landscapes).

Hide Picture
Press Command-H to toggle hiding the current picture. While the picture is hidden the menu bar 

and mouse reappear, and you can see the desktop in the normal way. Also, automatic advancing 
between pictures is disabled whilst the “Hide Picture” option is active.

To return to the slide show, press Command-H again.

File number
Even though GIF Slideshow makes viewing thousands of images on a CDROM very convenient, you

still have the practical problem that looking at each of, say, 6000 images takes quite a long time 
(over 8 hours at 5 seconds per image, not including coffee breaks!). By using the “File number” 
option you can re-position yourself to a nominated picture in a sequence. To do this, make a 
note of what picture number you are up to (press Command-P to show the sequence number). 
Then in a later session, after commencing viewing the same sequence of pictures (i.e. the same 
tag file, or folder) enter Command-F to bring up the “File number” dialogue box. Then enter the 
sequence number previously noted. Note that because GIF Slideshow has already read and 
decoded the next picture in sequence (to save time), the sequence number you have just 
entered will not take effect until the second picture along.

It is important that you are viewing pictures sequentially (not randomly) for this option to work. 
Re-positioning into the middle of a random sequence is not meaningful, as the random number 
generator is re-seeded each time, and therefore a given picture in a random sequence will be 
different every time. The “File number” option is disabled if you are viewing pictures randomly.

Loop Continuously
Press Command-L to toggle looping through the pictures. If the “Loop” option is active then once 

all pictures that you have selected have been displayed the display will start again from the 
start.

Random sequencing
Press Command-R to toggle random sequencing of pictures on and off. A message will briefly 

appear in the bottom right-hand corner of the screen to show what the new status is (Random 
or Sequential advancing).

The sequencing method (random or sequential) is remembered by GIF Slideshow for the next time 
you use the program.

Random sequencing is very useful for viewing CDROMs with thousands of pictures. Without 
random sequencing you would always see the files at the start of the CDROM, and never the 
ones at the end (unless you watched for hours and hours!).

When random sequencing is active the next file to be shown is chosen randomly from the ones not 
yet seen. This guarantees that you will always see each file once before any are repeated.

Used in conjunction with the “looping” option you can leave your Mac turned on all day with a 
suitable CDROM mounted to see a random selection of pictures that is always interesting!

Do not use random sequencing of pictures if you are planning to reposition to a given file number 
by using the “File number” option described above.
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Slideshow file options
The features described below appear under the “File” menu.

Read tag file
Press Command-T to process (read) a new tag file. All pictures listed in that tag file will then be 

displayed. You will receive an error message if the volume (i.e. disk/CDROM) that is named in 
the tag file is not mounted. In that case, mount the appropriate disk or CDROM, and re-process 
the tag file. The method of creating tag files is described further on in this document.

Scan folder
Press Command-S to scan a folder as described earlier in this document. Once you have selected a

file and clicked “Open”, all GIF pictures in that folder, and all sub-folders, will be selected and 
displayed.

Make a tag file
Press Command-M to make a tag file containing the names of all GIF pictures which are in the list 

of files being currently displayed. This process is described in detail further on in this document.
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Write as …
Press Command-W to write a copy of the GIF picture being currently displayed. You can use this to

make copies onto your hard disk (or a floppy disk) of favourite pictures that you see whilst 
scanning a CDROM. In effect, this is the same as making a note of the file name, and using the 
Finder to copy the file from the CDROM to your disk. Please note that you should not infringe 
any copyright that might pertain to the image being copied.

When writing a copy of a GIF picture you are given three choices of file format:

• GIF (Graphics Interchange Format)  — this is the fastest and probably the smallest option, 
fastest because it is just a copy of the original GIF picture, which is already compressed. 
Smallest because GIF pictures are always stored internally with LZW compression. Use this 
format if you want to view this picture later on using GIF Slideshow.

• TIFF — use the TIFF (Tagged Image File Format) if you want to import a copy of the picture into 
a word processor, desktop publishing program, or graphics program that does not support GIF 
pictures. TIFF pictures are more widely supported than GIF pictures, particularly by Macintosh 
programs. Note that, at present, GIF Slideshow cannot read TIFF pictures back in (this is 
currently under development) so pictures saved in TIFF format cannot be later viewed by this 
version of GIF Slideshow. Once you have decided to use the TIFF format, you have a choice of 
compressed or uncompressed files.
• TIFF compressed files are saved using LZW compression (similar to GIF pictures). A TIFF 
compressed picture will be a similar size to a GIF picture. The compression (and decompression
later on when loading the picture into another program) makes this format slightly slower to 
use than uncompressed TIFF images).
• TIFF uncompressed files tend to take two to three times as much disk as TIFF compressed. 
However they are faster to save, and load later on. Also, some other programs may not support 
TIFF compressed pictures. If you cannot load a TIFF compressed picture into another program, 
try the TIFF uncompressed option.

Quit
Press Command-Q to quit viewing pictures and exit to the Finder.
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Slideshow information options
The features described below appear under the “Information” menu.

All of the options below can be “toggled” on and off. In other words, selecting the option the first 
time turns it on, selecting it the second time turns it off. The information requested is displayed 
in a rectangle on the bottom left-hand corner of the screen.

The options that you last had selected are remembered by GIF Slideshow at the end of each 
session so that the same options will apply when you start your next session.

File name
The file name of the GIF picture being currently displayed can be shown by using the “File name” 

option (or Command-N).

Free memory
The amount of free memory currently available to GIF Slideshow can be shown by using the “Free 

memory” option (or Command-K, as in K for Kilobytes).

General Information
General information about the picture is displayed if the “General information” option is active (or 

Command-G). This includes:
• Size of picture on disk
• Size of picture in memory once decoded
• Width of picture in pixels
• Depth of picture in pixels
• Number of colours used in the picture

Percentage scaled
The amount that the current picture is scaled (shrunk or expanded) can be shown by using the 

“Percentage scaled” option (or Command-J). If the percentage is 100% then the picture is being 
shown full size. If it is 200% then it is being shown at double size.

GIF Slideshow will always attempt to scale each picture so that it fits into the current screen, so 
that you do not need to “scroll” around to see the whole picture.

Note that scaling a picture takes longer than displaying it at full size, so that a picture shown at 
150% will appear to be drawn more slowly than one drawn at 100%.

Also, the scaling is always carried out so that the picture keeps its original proportions, so that a 
rectangular picture may have blank areas on the sides, or above and below. In this case, the 
picture is centred so that the blank parts are evenly on each side of the picture.

Sometimes a picture will appear to be “off-centre”. This is not a bug in GIF Slideshow, it is simply 
that the black areas on the side of the picture are part of the original GIF picture.

Because of the slower drawing times for scaled pictures GIF Slideshow will display at 100% any 
picture which would otherwise have been scaled in the range of 98% to 120%.

In order to allow for users who may be using very large screens, GIF Slideshow sets a maximum 
scaling factor of 400%. Pictures scaled larger than that would not only take a long time to draw, 
but would look “chunky”. Correspondence will be entered into if any users would like this limit 
changed.

For technical reasons, interlaced pictures are always scaled by an integral amount (i.e. 100%, 
200%, 300% or 400%).

If you do not want small pictures scaled up (enlarged), un-check the “Enlarge small pictures” 
option under the “Options” menu.
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Progress
The progress through the current list of pictures can be shown by using the “Progress” option (or 

Command-P). The display appears in the format, “File 45 of 3421”, indicating that you are 
viewing file number 45 out of a list of 3421 files.

This number can be entered into the “File sequence” dialogue box available under the “Slideshow”
menu so that you can reposition to a given point in a sequence of pictures.

If the files are being shown in random order then the number shows how far you are through the 
random sequence, not which file number in the list you are currently viewing.

If the “loop” option is active then the file number will reset to 1 when the sequence restarts.

Show when next ready
The moment that the next GIF picture is ready for viewing can be shown by using the “Show when 

next ready” option (or Command-Y). This displays a small white box on the bottom right-hand 
corner of the screen.

This is useful in conjunction with manual advancing of frames. Until the white box appears, 
pressing “space”, “enter”, “return” (or clicking) to advance to the next frame will not have an 
immediate effect, because GIF Slideshow is still decoding the next picture while you are viewing
the current one. Once the box appears you know that attempting to advance will result in 
immediate action.
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Program options
The features described below appear under the “Options” menu.

Black borders
GIF Slideshow automatically draws a coloured border around pictures which do not fully fill your 

screen. The colour of the border is selected for each picture at random. If you prefer to always 
have a black border select “Black borders” from the menu, or press Command-B. Sometimes 
pictures will seem to be off-centre or still have a black border. This is because the black border 
is part of the GIF picture, and is therefore drawn on the screen before the coloured border is 
added.

Dither when required
GIF Slideshow automatically dithers GIF pictures when your monitor is set to less than 256 

colours. The dithering process approximates colours by blending available colours to simulate  
other colours. This process slows down the drawing of the picture. If you prefer to see the 
pictures un-dithered, un-check this option.

Enlarge small pictures
GIF Slideshow automatically scales up (enlarges) pictures which are smaller than the screen. This 

makes the picture bigger, but at the sacrifice of looking more “chunky”. If you prefer smaller 
pictures to be shown at their actual size and centred on the screen, un-check this option.

Ignore single errors
Out of a collection of a few thousand GIF pictures there will usually be a couple that cannot be 

displayed either because:

• The picture was incorrectly saved and cannot be processed; or
• The picture uses a GIF file format the GIF Slideshow does not recognise.

Press Command-I to toggle the “ignore single errors” option. If the “Ignore single errors” option is
active then non-consecutive errors will be quietly ignored.

If however there are multiple consecutive errors (because, for example there is not enough 
memory to display pictures) then an error alert will appear.

This is particularly useful for running unattended displays of many GIF pictures.
Note that GIF Slideshow has been tested with thousands of commercially available GIF pictures 

with only very occasional errors.

Minimum free memory
Selecting this option displays an alert box showing the smallest amount of memory that GIF 

Slideshow had free in the current session. You can use this to “tune” the amount of memory that
it needs to display a particular series of pictures. For example, if you had 6000K allocated to 
GIF Slideshow, and after displaying an entire CDROM the minimum free memory available was 
1500K, then you can probably safely allocate only 4500K to GIF Slideshow next time you want 
to display that CDROM. You would be advised to allow a “safety margin” of, say, 200K to be 
added to any figure obtained by the above method.
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Process “.FLI” files
GIF Slideshow has some rudimentary support for Autodesk Animator “.FLI” files. If you have a 

“.FLI” file on disk you may find that GIF Slideshow attempts to process it and display it in 
animated form. This display routine is still under development, and the displays therefore may 
not be correct, or at the correct speed. If you wish to disable recognition of “.FLI” files when 
scanning a CDROM, un-check this option.

Warn if screen not 256 colours
Because GIF Slideshow displays pictures most efficiently (quickly) when your screen is set to 256 

colours, it automatically warns you if your screen is set to some other number of colours when 
the application starts up (providing your screen supports 256 colour mode). You can disable this
warning message if you find it annoying by un-checking this option.

Help
The help item brings up a small summary help screen. This is useful to remind you of the basic 

program operational features, particularly if you have not used the program before. The help 
screen can also be accessed by pressing Command-?, the “Help” button on your keyboard (if you
have one), and the “Help” button which appears on the “About box” which is accessible from the
Apple menu.
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Tag files
Tag files are files created by GIF Slideshow which basically list the names and folders of every file 

being currently viewed. These have a number of uses:

• Tag files are generally much faster to process that scanning an entire folder or disk looking 
for GIF pictures (6 to 10 times as fast!)

• Tag files can be loaded into a word processor or spreadsheet and edited so that pictures 
appear in the desired order

• Whilst viewing pictures, by pressing an alphabetic key (i.e. “A” to “Z”) that key is recorded in 
the tag file. If you advance to the next picture by pressing “space”, “return”, “enter”, clicking
the mouse, or by using the automatic advance feature, a tag character of “space” is recorded 
against that picture. Pictures that have never been viewed have a tag character of ‘#’ 
recorded against them. By sorting the tag file inside a spreadsheet you can create new tag 
files that list pictures in certain categories. For example, you might press “F” for Fish, “M” 
for Mountains and “P” for people. By loading the resulting tag file into a spreadsheet and 
selecting all of the “P” entries you could create a new file that listed people only.

To make a tag file, press Command-M (“M” for Make tag file) while you are viewing a series of 
pictures. You will be asked for the name of the tag file. Then, when you have finished viewing 
your pictures the tag file will be written. 

It does not matter whether you make the tag file (i.e. press Command-M) before or after you tag 
each picture by pressing a key in the range “A” to “Z”. The tag file is only written once you have 
finished viewing the pictures (i.e. by reaching the end of the list of pictures, or pressing “Esc” or
Command-period). Any pictures not tagged at that stage have the ‘#’ character recorded 
against them.

The tag file can be read into a word processor or spreadsheet. The format of each line is:

• Volume name (e.g. GIFS_GALORE:)
• Folder number (this is a unique number that identifies each folder on a volume). Do not 

change this number or GIF Slideshow will not be able to locate that file in the future. When 
tag files are written, GIF Slideshow writes a comment line each time the folder number 
changes, so that you know the equivalent folder name corresponding to the folder number.

• File name (e.g. WIZARD.GIF)
• Tag letter

Each of the above fields are separated by tab characters, so that they can be processed by any 
program that recognises tab-delimited text (e.g. spreadsheets, word processors and databases).

Comment lines may appear in tag files. These must start with two hyphens (i.e. “--”).
GIF Slideshow inserts some comment lines of its own. Each file written starts with a comment 

indicating when it was produced, and as mentioned above, each time the folder number changes
a comment line is written identifying the actual folder name corresponding to that number.

Example tag file
A typical tag file might look like this:

-- Tag file created on Friday, 5 November 1993 at 8:01:23 PM
--
-- Directory ID 388358 is the folder: “GIFS:PEOPLE”
GIFS_GALORE: 388358 ABE3.GIF;1 A
GIFS_GALORE: 388358 ABRUS02D.GIF;1 B
GIFS_GALORE: 388358 ACACIA.GIF;1 B
GIFS_GALORE: 388358 ACTG22AG.GIF;1 X
GIFS_GALORE: 388358 ADMONI.GIF;1 X
GIFS_GALORE: 388358 ADPCOP.GIF;1 D
GIFS_GALORE: 388358 AEYE.GIF;1 #
GIFS_GALORE: 388358 AFACE_BW.GIF;1 D

Note the tag letters in the right-hand column.

Size of tag files
As an example, the tag file produced by GIF Slideshow for the “GIFs Galore” CDROM, which has 

6,483 GIF pictures on it, occupies 231,874 bytes of disk, or approximately 36 bytes per image.
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Speed
The time taken by GIF Slideshow to display an image is dependent on a number of factors:

Size of the file on disk
The larger the file, the longer it takes to read from disk or CDROM. Also, the larger the file the 

longer it takes to be decoded. GIF pictures are stored internally in a compressed form using the 
LZW (Lempel, Ziv, Welch) technique. Before being displayed the image must be decompressed.

The decompression routine used by GIF Slideshow was written (or should I say “hand-crafted”?) in
assembler code to make it as fast as possible. 

Scaling factor
Copying the decompressed picture from the area of memory into which it has been decompressed 

onto the screen takes a single Mac Toolbox instruction (CopyBits), except for interlaced images, 
discussed below. CopyBits works fastest when it does not have to scale images, and particularly 
slowly if the scaling is not an integral amount. In other words, scaled pictures will display at the
following rates:

• 100% scaling — fastest
• 200% scaling — slower
• 150% scaling — slowest

Number of screen colours
GIF Slideshow decodes images internally into 8-bit colour mode (i.e. 256 colours). Thus they will 

be copied to the screen fastest by CopyBits if the screen is also set to 256 colours, as this 
effectively means just a simple memory-to-memory copy (unless the image is scaled).

If your monitor is set to 16 colours or less you will notice a significant performance degradation.
Also, if the monitor is set to less than 256 colours, GIF Slideshow automatically “dithers” the 

image to make it more readable (unless you have un-checked the “dither when required” 
option). This also slows the display.

Interlaced pictures
Some GIF pictures are stored in “interlaced” form. You can easily detect these because they are 

drawn in four phases, starting with a coarse image and gradually becoming finer.
Unfortunately these take somewhat longer to draw because rather than a single “CopyBits” 

instruction to copy them to the screen, the application has to do a few hundred, in order to 
insert the correct parts of the image into the correct position on the screen. There is nothing 
you can do to speed up these images, particularly if they are on CDROM and cannot be 
changed. If the image is on a hard disk you could open it with a program that edits GIF images 
and re-save it as non-interlaced.

Time taken to scan disks or folders
This topic was covered earlier in this document under the section “Selecting pictures to be 

displayed”. The most important point covered was the fact that reading in a “tag file” produced 
by GIF Slideshow is at least 6 times as fast as scanning a disk looking for images. You are 
strongly advised to produce tag files of your favourite CDROMs or disks.
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Summary of Command Key Equivalents
File menu

Read tag file........................Command–T

Scan folder..........................Command–S

Make tag file........................Command–M

Write copy of GIF.................Command–W

Quit......................................Command–Q

Slideshow menu
Automatic advance..............Command–A

Delay time............................Command–D

File number..........................Command–F

Hide picture.........................Command–H

Loop.....................................Command–L

Random sequence...............Command–R

Stop show............................Command–Period (or Esc)

Information menu
File name.............................Command–N

Free memory.......................Command–K

General information.............Command–G

Percentage scaled...............Command–J

Progress..............................Command–P

Show when next ready........Command–Y

Options menu
Black border........................Command–B

Enlarge small pictures.........Command–E

Ignore single errors..............Command–I

Minimum free memory.........Command–U

Help.....................................Command–?

Not on a menu
Advance to next picture.......Space, Return, Enter, “A” to “Z” or click mouse
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Future versions
The author has plans for future enhancements including the following:

• Ability to selectively display images from “tag” files (e.g. all pictures tagged with “F”).
• Ability to selectively display images from “tag” files based on file names (e.g. all files with “fish” 

in their name)
• Ability to copy a picture to the clipboard
• Handle newer GIF formats
• Read other files types, such as TIFF, or PICT
• Support for Macs with multiple screens
• Faster loading of tag files
• Better support for Macs with smaller amounts of memory
• When saving GIF or TIFF pictures, make the icon on the desktop show a thumbnail of the picture
• Suggestions from users

Note that the likelihood of such enhancements being developed and released are in direct 
proportion to the number of ShareWare fees received by the author. If you enjoy using GIF 
Slideshow please send in your fee—don’t rely upon “someone else” doing it!

GIF file recognition
GIF Slideshow uses the following method to recognise GIF pictures when scanning folders or 

disks:
• Files of any name, with a file type of “GIFf”. Most Mac GIF pictures will be in this format.
• Files of type “TEXT” with a file name that contains the characters “.GIF”. Most GIF pictures on 

ISO 9660 CDROMs are in this format.

Autodesk Animator file recognition
GIF Slideshow has some rudimentary support for Autodesk Animator “.FLI” files. If you have a 

“.FLI” file on disk you may find that GIF Slideshow attempts to process it and display it in 
animated form. This display routine is still under development, and the displays therefore may 
not be correct, or at the correct speed. If a “.FLI” animation is being displayed you need to 
press “space”, “enter” or “return” to advance to the next picture/animation, even if “Automatic 
advance” is active. 
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Copyright
GIF™
The word GIF™ stands for “Graphics Interchange Format™”. GIF and “Graphics Interchange 

Format” are trademarks of CompuServe Incorporated. CompuServe® is a registered trademark 
of CompuServe Incorporated.

TIFF
The word TIFF stands for “Tagged Image File Format”. It is a file format developed jointly by Aldus

Corporation and Microsoft Corporation.

GIF Slideshow
GIF Slideshow is © Copyright 1993 by Nick Gammon. All rights are reserved.

Think C
GIF Slideshow was developed using Symantec’s Think C™, version 6.

ShareWare
GIF Slideshow is being distributed by the ShareWare method. Permission is given for copies to be 

distributed via bulletin boards, CompuServe®, User Group collections, and CDROMs containing
ShareWare or Public Domain files, providing in each case that this documentation accompanies 
the GIF Slideshow application, and that neither the documentation nor the application is 
changed.

Any other form of commercial distribution is prohibited, unless by prior written agreement with 
the author.

ShareWare fee — $20
If you find GIF Slideshow useful please forward a ShareWare fee of $US 20 (US dollars) to:

Nick Gammon
PO Box 124
Ivanhoe  VIC  3079
AUSTRALIA

Australian residents: Please forward $A25 (Australian dollars).

Comments, suggestions, bug reports and so on are welcome and should be forwarded to the above 
address, or addressed to the author on CompuServe at address 100033,1340. If you find GIF 
Slideshow cannot correctly reproduce some GIF files, forwarding a copy of the file in question 
would be helpful. Before doing so it would be advisable to check with the author by writing or 
message on CompuServe (see below) as to whether you are using the latest version.

Sorry, it is not practical for any disks forwarded to the author to be returned.

Bugs
Bug reports
If you believe you have a GIF file that is not being correctly processed by GIF Slideshow, either 

because of an error message on the screen, or because the picture displayed looks like rubbish, 
before reporting an error to the author of GIF Slideshow, please check to see whether the file 
can be correctly processed by another application that reads GIF files—for example, Adobe 
Photoshop. If the picture is correctly displayed by the other application, then you have probably 
found a bug in GIF Slideshow’s decoding logic. If the picture is not correctly displayed by the 
other application, then you probably have a corrupted GIF file.

If you have other problems, such as the program “crashing” or “hanging” please advise which 
version of the System you are using (use the Finder menu item “About this Macintosh” to find 
out the System version number). Also please advise what model of Mac you are using, and how 
much memory you allocated to GIF Slideshow.
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Finally, please advise which version of GIF Slideshow you are using. Use the “About GIF 

Slideshow” menu item under the Apple menu to find this out.

CompuServe® address
Messages can be sent to Nick Gammon on CompuServe at address: 100033,1340


